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Introduction
Dreamweaver is a powerful web development tool.  But new
users often find getting started with Dreamweaver to be a
daunting task.  The purpose of this guide is to get you up
and running with Dreamweaver 4 quickly.  In fact, you will
likely have a web site up on the Internet by the end of your
very first session. Once you become acquainted with
Dreamweaver, you’ll find it is also a very easy tool to use.

With this guide you will learn how to construct your own
personal web site.  While any reason would do, this guide
uses the project of constructing an electronic portfolio re-
flecting your personal and professional experiences.  Like
any portfolio you will be able to show evidence of your pro-
fessional experiences, skills, and interests.  Because the port-
folio will be web-based, anyone in the world who has access
to the Internet and a web browser (such as Netscape or
Internet Explorer) can visit it, including family and friends,
colleagues, teachers, and prospective employers.

This guide is presented in three sessions:

1) How to construct a new HTML document from
scratch;

2) How to link your HTML document to other web
pages; and

3) How to add graphics and backgrounds to your HTML
documents.

Each session is designed to be completed in one sitting (no
more than one hour), though the actual completion time will
vary from person to person.

This guide was written to go along with Dreamweaver ver-
sion 4.  Please be aware that there are many important dif-
ferences between this and earlier versions of Dreamweaver.

I designed this guide
for educators, hence
I use educational
examples
throughout.
However, the guide’s
basic structure to a
portfolio is relevant
to any professional.
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How to use this guide

In each section, you will be asked to perform a series of
steps to complete the project.  Each step to be performed
will be preceded by a check box, such as this:

Select “Preferences” from the “Edit” menu.

Follow the instructions carefully and check off the step when
it is completed.  This will help you from getting confused
and disoriented.  In the event that you make a mistake,
these check boxes will help you to retrace your steps.
Explanations and illustrations will accompany these steps.
The illustrations represent what you should actually be
seeing on your screen.  You should strive to ensure that
critical elements of illustrations match exactly what you
see on your screen.

However, you will encounter lots of situations in which
general features of illustrations will never exactly match
what you see on the screen, such as the relative positions
of windows.  The graphical user interface (GUI) of
Dreamweaver results in all kinds of variations that have
no bearing on the final result.  Rest assured that I’ll try to
alert you to those times when absolute accuracy is required.

Of course, it is possible that you will follow and check off
each and every step and still feel hopelessly lost at some
point.  When the inevitable happens, try not to panic.
Instead, carefully retrace your steps starting at the last
point where things seemed to be working.  Try to approach
these situations with the attitude of a creative problem-
solver confronted with a challenge.

What you are expected to already
know

This guide assumes you already understand basic comput-
ing concepts, such as how to create and save files with ap-
plications such as Microsoft Word.  It also assumes you have
been successfully browsing the World Wide Web with appli-
cations such as Netscape or Internet Explorer.

This guide will not teach you everything there is to know
about Dreamweaver — it’s not designed to.  Therefore, after
completing this guide, it is strongly recommended that you
find and use other resources to thoroughly learn
Dreamweaver and its many features.  A good place to start
is the reference manual that accompanies Dreamweaver.
Fortunately, the popularity of Dreamweaver has generated
many excellent third party books as well.
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Copyright Information

This book is copyrighted and is being distributed using the
“shareware” method — you can copy this book without con-
sulting me, but if you use any or all of this book in your
learning or teaching, you are legally obligated to send me
the royalty fee.  If you choose not to use this guide, either
destroy the copies you have made immediately, or give them
to another person to try.  If you were given this guide by a
friend or teacher, you too are obligated to pay for it if you
use it regardless if they sent in their payment.  (Of course,
feel free to log on to my web site and get yourself a fresh
copy!)

The royalty fee as of the date at the bottom of this page is
$10 (US) for educators and students who use this guide as
part of a class at a not-for-profit school and $20 (US) for
everyone else. Send your payment to the following address:

Lloyd Rieber
6114 Nowhere Road
Hull, Georgia 30646
USA

Checks or money orders should be made payable to “Lloyd
Rieber.”  All payments need to be made in US funds.

This royalty fee is subject to change every six months.  If
you obtain a copy of this guide after six months from the
date below, please consult the following web site for the most
current royalty fee amount:

http://www.nowhereroad.com/dreamweaver

I will also update this guide as needed to correct mistakes
and make other improvements, so be sure to get the most
recent version.

I will acknowledge your payment upon receipt.  As a little
extra incentive, I will also send you free-of-charge the URL
of an additional Dreamweaver 4 lesson on how to create
simple rollover graphics that link to other web pages and
how to embed music into a web page that plays automati-
cally when the page opens.

Remember, if you use any part of this guide and do not send
payment promptly, you and/or your institution are in viola-
tion of copyright.  Please support me in trying to get quality
materials into the hands of people quickly, without hassles,
and at a reasonable cost.  And besides, guilt is a terrible
thing!

Version: January 16, 2002
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Session 1:
Constructing a new HTML

Document

Dreamweaver provides an easy way to construct web pages
without having to learn Hypertext Markup Language pro-
gramming, more commonly known as HTML.  Instead, we
can use Dreamweaver like a word processor.  There are some
key differences between Dreamweaver and word processors,
however.  One of the biggest differences you will notice later
is how graphics are handled.  You can also use Dreamweaver
to easily link one web page to another.  In this session, you
will learn how to construct a single web page from scratch.

Let’s begin by getting a disk ready.  It’s a good idea to dedi-
cate an entire disk to the web construction process.

Preliminary

This guide is being written for students who most likely
will be working in a computer lab at school. For that reason,
we are going to store all original files associated with our
web site on removable media, such as a floppy or zip disk. It
will be easier and less confusing to transport the files easily
between school and home. (Of course, it will be important to
back up our files from time to time.)

Format a new disk dedicated to web page
construction.

Make a new directory on this disk and name it
“portfolio”; type in all lower case letters:

Dreamweaver allows
you to view and modify
the raw HTML code that
it automatically
generates as you use
its “point and click”
interface.  If interested,
you might find this a
good way to learn
HTML.  However, many
people build quite
sophisticated web sites
with Dreamweaver
without ever having to
deal directly with
HTML.

Beware!  Go slow
and check off all the
boxes as you
complete the steps.
You’ll save time by
taking your time and
making sure you
understand each
step.

It doesn’t matter if you
use a floppy disk, a zip
disk, or some other
form of removable
media, but your choices
may be limited to the
computer you are
using.

The screen shots in
this guide were
taken from the
Windows version of
Dreamweaver 4.
Fortunately, the
differences between
the Macintosh and
Windows versions
are slight, so
Macintosh users
should have no
problem using this
guide. When
differences are
important (such as
control-clicking
instead of right-
clicking), they will be
pointed out.

The portfolio directory
is your “root directory ”
for your entire web site.
This means simply that
everything related to
your web site must be
contained within this
directory. The
importance of this
concept will be
emphasized throughout
this guide.



Introduction to Dreamweaver 4 7Session 1:  Constructing a new web page

It’s a good idea to give some thought to the overall design of
our web site, such as its main parts or functions.  Although
we will not deal with how to insert graphics or images into
our web pages until Session 3, it’s a good idea now to plan
for their eventual need. A good strategy is to create sepa-
rate directories for any resources we may be using.

Open the portfolio directory and make another
directory inside it called “images”:

Great! We have created the essential first elements of our
web site! Time to launch Dreamweaver 4.

Launching the Dreamweaver 4
Application

Launch the Dreamweaver 4 application.

Windows users: Click on the Start button and launch the
application:

There are currently two
Dreamweaver 4
products available from
Macromedia. One is
simply called
Dreamweaver 4 and
the other is called
Dreamweaver UltraDev
4. UltraDev is sort of a
“souped up” version of
Dreamweaver.
UltraDev’s most notable
enhancement is that it
can connect to on-line
databases to get and
store information. The
Dreamweaver part of
each application is the
same, so this guide will
work fine with either
version. (The screen
shots in this guide
come from the UltraDev
version.)
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Macintosh Users: Find and double-click on the
Dreamweaver application 4 icon:

A blank screen appears with the title “Untitled Document”:

There are several windows or palettes that open automati-
cally: Document Window, Object Palette, Property Inspec-
tor, and Tool Bar. There are many, many more windows that
can be opened as well! We’ll explain and use these windows
as we go.

For now, just think of Dreamweaver as a word processor.

Object Palette

Property Inspector

Tool bar

Menu bar

Document Window

Your screen may
just read
“Dreamweaver 4”
instead.

Other windows may
also be open at the
start, such as the HTML
Styles and Reference
windows. It’s safe to
close these and others
for now. You can
always reopen them by
using the “Window”
menubar.
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Entering and formatting text

Let’s begin building a personal home page by typing a short
biographical statement about yourself.

Type your name, followed by a brief statement
about yourself, patterned after the following:

Also notice the three phrases I typed at the end.  Later, these
topics will act as a menu where each topic links to a sepa-
rate web page.  We will learn how to construct links to other
web pages in the next session.  The use of organizing text,
such as this simple menu, is a good first step to designing
your web site.

It’s also a good idea to type a “title” for your home page. This
title will appear at the top of the browser window when
people access your page.

Type something like “Lloyd Rieber’s Home Page”
in the window beside “Title:”

Obviously, you
should type your
name and
information about
yourself here
instead!

When someone
accesses your web site
on the Internet, this title
will appear at the top of
their browser window. If
they bookmark your
site, this title will be the
name of their
bookmark.
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Saving your page to disk

Like working with any file, it’s important to save early and
often. Saving here is as easy as with any other application.
However, it’s very important that the name of the file be
given special consideration. Some web servers are case sen-
sitive, so we need to pay attention to our use of lower and
uppercase letters (we’ll stick to all lower case). We also need
to avoid using special characters and spaces. Finally, all web
files must end in one of several special extensions. For ex-
ample, we are going to name our first file a very special
name called “index.html”. We’ll explain in a moment why
the name  “index” is being chosen. But, most important, we
need to make sure that the extension “.html” gets added to
the name.  Without this special extension, the web browser
won’t interpret it as an HTML document and instead will
display strange characters to the viewer.

Different versions of Dreamweaver use different default
settings for this extension. Before we go any further, let’s
check the Preferences and make sure that the right exten-
sion is going to be added to our file.

Select “Preferences” under the “Edit” menu.

Notice all of the different categories of Preferences to the
left! Obviously, many changes can be made here. Be sure
that you are looking at the “General” category of Preferences.

Notice which extension is listed beside “Add Extension when
Saving”:

Again, I happen to be using Dreamweaver UltraDev 4, in-
stead of regular Dreamweaver 4. The UltraDev version con-
tains features related to connecting to on-line databases. As
you can see, the default extension with my application is
“.asp”, which stands for Active Server Pages (a format of
pages that gets or puts information into a database). Your
version might contain the extension “.htm”, which is a typi-



Introduction to Dreamweaver 4 11Session 1:  Constructing a new web page

cal extension for people who use a Windows computer as
their web server. Either “.html” or “.htm” are perfectly ac-
ceptable for our purposes. However, I will be using “.html”
throughout this guide, and so I will change this extension
accordingly in the text window.

Change the extension in the text box to “.html”.

Of course, the other option would be to simply turn off this
option and manually add the extension every time we
save. But, let’s leave it like this for now.

Click “OK”.

Let’s now turn our attention to saving the file.

Select “Save as...” under the “File” menu.

Save your file to the “portfolio” directory  on your
disk with the name “index”, such as the
following:
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Dreamweaver will automatically add the “.html” extension
for you.

Click “Save.”

You have to “trust” Dreamweaver to add the extension for
you. It’s a little clearer to Macintosh users, because
Dreamweaver actually shows the extension about to be
added:

Why the name “index.html”?

Home pages for web sites are typically named “index.html”
because this is a very special file name for web browsers.
When you enter a web site without pointing to a specific
file, the web browser looks for a file named “index.html” in
that directory. If found, it displays it. This is a nice way to
keep web addresses a little simpler to remember. For ex-
ample, the address for my personal web site’s home page is
“http://www.nowhereroad.com/index.html”. However, you
can just type “http://www.nowhereroad.com” and it still
works.  There are other special names as well, such as
“default.html” or “home.html”, but “index.html” is the stan-
dard.

Let’s turn out attention back to the content on our page.

Continue to type additional text as you would in
a word processor. Be sure to save often as you
go.

You might add some additional topics to your menu, such as
“My Educational Philosophy,” or “Instructional Materials I
Have Developed”. You know, topics that might be found in a
professional portfolio.
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Formatting text

The procedures for formatting your text are similar to those
of any word processor.  However, the choices are limited to
only the format options supported by HTML.  You will also
need to get familiar with the HTML terms for formatting.
For example, the format for standard text is called “Para-
graph.”  Let’s change the format for the first line containing
our name.  Let’s put our name in large letters centered on
the screen.

Like any word processor, the first step is to highlight the
text you wish to format.

Highlight your name by clicking, holding, and
dragging the mouse over the letters in your
name.

Next, we need to change this text from “Paragraph” to “Head-
ing” with the largest text available.

Select “Heading1” from the “Format” menu in
the Property Inspector:

You’ll find the choices
quite limited as
compared to a word
processor.

Property Inspector

You can also add
color to your text by
clicking here.You can change fonts here.

However, be careful because if
the end user does not have a
particular font installed on their
computer, the default system
font will be substituted.
(Remember, too, that users
often choose to override a
page’s fonts with their own
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Next, click on the “center” symbol (be sure the
text is still highlighted).

When done, your name should be correctly formatted:

You will get more accustomed to the peculiar formatting
options as you work more with Dreamweaver.

Adding a horizontal rule

A good way to separate sections of a web page is with a
simple graphic called a horizontal rule.  Let’s insert two
horizontal rules — one after your name, and one  right be-
fore the menu choices.  First, let’s insert a blank space after
our name.

Click once after your name and press the Return
key once.

Click on this symbol to
center your highlighted
text.

Horizontal rule
button

Notice how the
button functions
appear as you pass
the mouse over
them.
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Click once on the horizontal rule button.

Edit your page as you would in a word processor,
formatting it as you wish.

For example, I edited my home page to the following:

Save your file periodically as you work!

The next two sessions will show you how to build links from
one page to another and how to insert graphics into your
web pages.

Previewing Your Web Page

Although Dreamweaver does a nice job of showing you what
your page will look like when it is actually “up and running”
on the Internet, it’s helpful to occasionally preview your page
in a web browser of your choice. The shortcut for doing this
is pressing the F12 key, but you have to have at least one
specific web browser identified (up to 20 different web brows-
ers can be chosen). It’s likely that your copy of Dreamweaver
has already chosen Internet Explorer as the default browser.
Of course, this implies that you already have Internet Ex-
plorer installed properly on your computer in a place that
Dreamweaver expects it. In a minute, we’ll explore how to
set up or change your preview browser list, but there is no
harm in just trying it out to see if it works.

Notice I added another
line of text that will be
used to link to a very
useful educational web
site offered by the U.S.
Department of
Education.

Two horizontal rules
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Select “File - Preview in Browser - iexplore” from
the menubar, or press F12.

If it works, Internet Explore will automatically be launched
and your Dreamweaver page will appear in a new window:

Notice that this is an
internet Explorer
window — you are no
longer in Dreamweaver.
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If it didn’t work, you may have received any number of mes-
sages, the most likely being that Dreamweaver couldn’t find
Internet Explorer and whether you would like to edit the
preview list. If you are using Dreamweaver UltraDev, you
probably were given this message:

Click “No” for now, just so you don’t get lost in the process
that will be explained below, even though we are ultimately
going to change this preference.

If Internet Explorer was launched and opened your page in
a new window for you, close this window and go back to
Dreamweaver.

Close all windows except the one containing
your web page in Dreamweaver.

Let’s go through the steps of selecting a web browser. Even
if things worked fine for you when you pressed F12, you
may want to use Netscape Explorer, or at least add it as a
secondary browser.

Select “File →Preview in Browser →Edit Browser
List...” from the menubar:

This brings up the Preview in Browser Preference dialog
box.

The first thing UltraDev users need to do is to turn off the
preference to “Preview Using Application Server”. This pref-
erence is needed for several of the database connectivity
tools featured in the UltraDev version. (Other Dreamweaver
users can ignore this.)

If you are using
Dreamweaver 4, not
Dreamweaver 4
UltraDev, you will not
get this message.
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If you are using Dreamweaver UltraDev, turn off
the preference to “Preview Using Application
Server” by clicking on the check mark to make it
disappear.

Next, we’ll quickly go through some of the steps to find,
add or delete a browser.

If Internet Explorer did not launch when you
pressed F12 earlier, but you know you have it
installed on your computer, click on the “Edit”
button.

The following dialog box appears:

Click on the “Browse...” button, then navigate
your way to the Internet Explorer application and
choose to open it; Click “OK” when done.

Let’s add Netscape Communicator (or Navigator) to our list
while we are here. Again, this assumes that you already
have Netscape Navigator installed on your computer.

In the “Preview in Browser” Preference window,
click on the small plus (+) sign beside
“Browsers”.

UltraDev User Alert!
Click on the check mark
(to make it disappear)
to turn off this
preference.
(Other Dreamweaver
users can ignore this.)

Windows Alert!
A good place to start
your search is in a
directory called
“Program Files” on the
C: drive.

Macintosh Alert!
If you don’t find Internet
Explorer as soon as
you enter your hard
drive, then first look for
an “Internet
Applications” folder,
followed by an
“Applications” folder.

The text beside
“Application” may be
missing or different.

Click here to edit the
selected browser in the
list.
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Click the “Browse” button and navigate your way
to the Netscape Communicator application and
choose to open it.

Click in the check box to make this your
secondary browser.

Your window should look like the following:

Click “OK”.

Your “Preview in Browser” Preference Window should look
like this:

Click “OK” to accept all the changes and to leave
the “Preview in Browser” Preference Window.

Press F12 as often as you like from here on to
preview your web page in your chosen primary
browser.

Click here to add a
browser to the list.

Click this button to
browse your computer
for the Netscape
application.
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Follow-up Activity

Practice the skills learned in this session by creating an-
other new Dreamweaver file to contain your professional
resumé.  If you already have a resumé typed into a word
processor, you can “copy and paste” it from the word proces-
sor into Dreamweaver.  Be sure to again save this
Dreamweaver file to the folder on your disk with a title of
your choice (e.g. “resume.html”).

Here’s an example:

Notice the sentence I included at the bottom — “Click here
to go to Lloyd Rieber’s Home page” — indicating, obviously,
a link back to my home page:

In the next session, you’ll see how to link the two files to-
gether.

Don’t get bogged down
at this point trying to
create the perfect
resume page with all
the possible information
about you. You will
have plenty of time later
to work on it. However,
be sure to create this
new page with at least
some token information
now — we will be using
this page to
demonstrate how to link
two pages together in
the next section.

However, remember
the earlier warning
about the difference in
formatting between
HTML and word
processors.  Even if
you copy and paste
your resume from a
word processor to
Dreamweaver, expect
to spend considerable
time reformatting the
Dreamweaver file.
Fortunately, most word
processors, such as
Microsoft Word, now
provide the option to
“Save as HTML...” The
files you save this way
can then be opened
and refined with
Dreamweaver.
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Taking a Look at your Root Folder

It’s useful to take a look inside your root folder at this point.
Recall that we made a directory named “portfolio” on a floppy
or zip disk at the start of this session. Now that you have
created at least two HTML files, your root folder should re-
semble the following:

As we finish this first session, consider how your entire
web site is now contained within the directory named “port-
folio”.  All the files you add or create, such as HTML files,
graphics (which we will cover in session 3), sounds, etc., will
be contained inside your “portfolio” directory.

It’s also a good idea to make a back-up of your root folder
onto your computer’s hard drive.

Make a back-up of your “portfolio” directory onto
the hard drive of your personal computer.

Uploading your files to a web server

Before others can access your web pages, you must upload
(i.e. transfer or copy) all of your files to a web server.  Fortu-
nately, Dreamweaver has excellent site management tools
that make “talking”  to a web server easy (i.e. uploading and
downloading files). These site management tools are cov-
ered in the Appendix. There are also separate FTP applica-
tions that you can also use to do this. FTP stands for “file
transfer protocol”. WS_FTP is the most common Windows
FTP application and Fetch is the most common Macintosh
FTP application.  Here is a good resource for learning how
to use these FTP applications:

http://www.arches.uga.edu/upload.html

However, there is no need to rush.  You can upload your files
at any time and as often as you wish. But if  you are anxious
to get “on the web,” either go through the Appendix now or
learn how to use an FTP application.

Windows Alert!
You might find it helpful
to see the extensions of
all files while working
through the rest of this
guide. To do this, you
will need to turn off the
option to “Hide file
extensions for known
file types.” This option
is found in the “Folder
Options” control panel
(click on the “view” tab).

Notice that my
HTML files are
associated with
Internet Explorer.
Your HTML files may
be associated with
Netscape instead,
meaning that
Netscape is the
default application
for your “.html” files.
If you double-click
on a file, your default
application will
launch and then
open the file. To
open these in
Dreamweaver, or
another appropriate
application, you
would have to
launch the
application first, then
open the file from
the application.
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Session 2:
Linking to Other Web Pages

As already mentioned, HTML stands for Hypertext Markup
Language.  The prefix hyper- translates best as “linking.”
In fact, one of the most powerful features of the World Wide
Web (i.e. the Internet) is the ability to link any web page
with another.  All you need is the web address (called a “Uni-
form Resource Locator,” or URL) of the web page to which
you wish to link.  Instead of learning all of the HTML com-
mands and programming the web page ourselves (with a
text editor), this session again shows you how to use
Dreamweaver to construct these links.

Preliminary

Insert your disk and open the directory titled
“portfolio”.

Obviously, we need to launch Dreamweaver to continue
working on our web site. However, if you are working in a
Windows computer, notice that your “index” and “resume”
files are considered as “belonging” to Internet Explorer on
my computer (as signified per the blue “e”). Therefore, if I
double-click on the file, Windows will launch Internet Ex-
plorer instead of Dreamweaver. Your files may be associ-
ated with Netscape instead, meaning that Netscape is the
default application for your “.html” files. If you double-click
on a file, your default application will launch and then open
the file. We don’t want that. To open these in Dreamweaver
we have to first launch the Dreamweaver application first,
then open the file from Dreamweaver.

“http://www.ford.com” is
an example of a URL.
Later you will form your
personal URL, which
will become your
address on the World
Wide Web.
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On a Macintosh computer, in contrast, the files are identified
as Dreamweaver files and double-clicking on either will launch
Dreamweaver:

However, for consistency between platforms (and to avoid any
confusion), let’s get in the habit of launching Dreamweaver
first, and then opening a file from within Dreamweaver.

Launch the Dreamweaver application.

From Dreamweaver, open the file “index.html”:
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Linking Your Personal Web Page to
Another Web Page Already on the
Internet

Let’s build our first link to the “Federal Resources for Edu-
cational Excellence Home Page” at the bottom of the page.
We are going to make these words active, or “hot,” meaning
that when a user clicks on them, they will be immediately
taken to this web page.

The first step to making any word, phrase, or sentence ac-
tive or “hot” (i.e. linking to another page) is to highlight the
text.

Highlight the sentence “Federal Resources for
Educational Excellence Home Page” by clicking,
holding, and dragging over the letters of the
words:

Alternatively, you could have clicked on the paragraph tag,
marked “<p>” in the bottom left hand corner. This refers to
the text associated with this tag. This is a handy shortcut in
Dreamweaver.

Next, type the web address (URL) in the text box at the
bottom left of the screen (beside the small globe).

Click once in the text window beside “Link” in
the Property Inspector and type the URL for this
web page:

For example, here is the URL for this government web site:

http://www.ed.gov/free/

A shortcut to
selecting a block of
text is clicking on
one of the HTML
tags located here,
such as the <p>
(paragraph tag). You
will see this list of
tags change,
depending on the
tags at the text
insertion point (i.e.
where the vertical
bar is flashing).

Type the URL here
Property Inspector

This address is an
example of an
absolute link . We will
contrast this to a
relative link  in the next
section of this session.

Instead of typing
this manually (and
perhaps making an
error), you could
launch a web
browser (such as
Netscape), go to
this web page, and
then copy and
paste this address
from the web
browser to
Dreamweaver.



Introduction to Dreamweaver 4 25Session 2:  Linking to other web pages

When finished, press return.

Notice that these words have now changed color and they
are underlined.  This indicates that the text is “hot,” mean-
ing that it will link to another web page when clicked.

It’s also important to tell Dreamweaver where to open this
link. This is called the target. The most typical targets are
the parent window (the new page will replace the old) or a
blank window (the new page will open in its own window).
This is an important decision, as it can be very disorienting
if the user expects it one way and opposite happens. In this
case, it makes sense for the new page to open in a blank
window because the link is “outside” of our web site.

Click on the little triangle beside “target” in the
Property Inspector to show the pop-up menu:

Choose “_blank”:

Previewing the Page to Test the Link

We can test this link by previewing the page in Internet
Explorer.

Press F12 to preview our file in Internet Explorer.

Move the mouse over the “hot text” and notice
that the web address now appears in the text
window at the bottom of the screen:

Pressing return is
just one way to tell
Dreamweaver to
accept this text.
Another way would
be to press the tab
key, or simply to
click on any spot in
the document
window.

Refer to session 1 for
identifying one or more
web browsers for
previewing
Dreamweaver
documents.

Click here to activate
the pop-up menu.

Be sure “_blank”
appears in the target
window.

The URL of this “hot
text” appears here in
the web browser.
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Why stop there? Let’s see if the link really works.

Click on the hot text to go to this government
web site:

Notice that this link opened in its own window, due to the
fact that we selected “_blank” for the target.

Have you saved recently?

Select “Save” from the “File” menu.

Find several web pages on the Internet that you
wish to link from your home page and write down
their addresses (URLs) carefully.

If any of the web addresses have even the slightest error
(such as a lower case letter “l” instead of the number “1”),
the link will not work.  A good strategy is to run Netscape or
Internet Explorer while you are using Dreamweaver so that
you can just copy and paste web addresses as you find them.
This guarantees that the web addresses will be correct.

Construct “hot text” to link to each of these web sites.

For example, I constructed links to the following web sites:

This only works if you
have a live Internet
connection.

None come to mind?
Try these:

Public Television
http://www.pbs.org

Smithsonian Institution
http://www.si.org

U.S. Civil War Center
http://www.cwc.lsu.edu/
civlink.htm

World Lecture Hall
http://www.utexas.edu/
world/lecture/

NASA
http://www.nasa.gov/

Bad Science
http://www.ems.psu.edu/
~fraser/BadScience.html

This is called a
bulleted or
unordered list. To
make it, choose
“Text - List -
Unordered List” from
the file menu.
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Linking two Dreamweaver files

Dreamweaver offers an easy way to link one Dreamweaver
file with another.  You must have another Dreamweaver file
already constructed in order to complete this section (such
as the web page you constructed to contain your professional
resume as discussed in the “Follow-up Activity” in session 1
on page 20).

The first step is to highlight the text that will become the
link to the second page.

Highlight the text “Professional Resume” in the
index.html file:

Next, we need to tell Dreamweaver which file on the disk
(in our root folder) we want this text to link to.

Click on the small graphic of a folder to the right
of the text box beside “Link”.

A standard file dialog box appears. If necessary, navigate to
the “portfolio” directory on your disk.

Select “resume.html’.

Remember the
shortcut of clicking
on the <p> tag?
(Your text cursor
needs to be blinking
somewhere on the
desired text block
first.)

After you highlight the
text for the link, click
here to point to the
page on the disk you
want to link to.
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Before we click “OK”, it’s useful to notice one very impor-
tant thing on this dialog box. Notice in the URL text box
that the usual “http://...” does not appear. Instead, only the
name of the file appears. That is because the link to
“resume.html” is relative to the file “index.html”.  The dif-
ference between relative and absolute links is one of the
most fundamental principles in web design.  Again, this
speaks to the importance of a root folder. Links from one file
in the root folder to other files or resources in the root folder
are all relative to each other.  When you type “http://” in
front of a URL, the link goes absolutely to one and only one
location on the Internet. When the link is relative, the root
folder can be anywhere on the Internet — your browser is
smart enough to figure out how to determine the rest of the
URL.

Click “OK” to accept the link.

Let’s take moment to study the result:

Notice that the text again changed to blue. Most important,
notice that the relative link to “resume.html’ appears in the
Inspector Window beside “Link”. This means that when we
preview the link, our web browser will look for a file called
“resume.html” in the same directory as it had found
“index.thml”. We’ll just leave the target empty at this point.

Just so you know, you could have instead just typed the name
of the file you wished this text to link to. However, this pro-
cedure makes it very easy to quickly link any Dreamweaver
file to another, thus facilitating the construction of a com-
plex web site.

Let’s save the file before we test the link.

Save your file.

OK, let’s see if the link works by previewing the page in
Internet Explorer.

I know this is still
probably as clear as
muddy water — if so,
don’t fret. It will become
clearer as we go.
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Press F12 to preview the page in Internet
Explorer.

Click on the link to “Professional Resume”; the file
“resume.html” from your disk should appear in the browser
window:

Cool!

Of course, we’re a little stuck right now because there is no
obvious way to get back to our home page. Fortunately,  we
have already designed the text to get us there at the bottom
of this page. All we need to do is go back to Dreamweaver to
set up another link there to take us back. No problem!

Close the Internet Explorer window and select
the Dreamweaver window.
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Choose to open the “resume.html” file from the
“portfolio” directory on your disk.

Highlight all the text beginning with “Click here
to go to...” at the bottom of the page.

Click on the small folder graphic in the Properties
Inspector window beside “Link”.

Select “index.html” from the “portfolio” directory
of your disk:

Click “OK”.

Again, you could just
type the name of the
file you wish this text to
link to in the text box
beside “Link” —
“index.html’ in this case.
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The URL link should show “index.html’:

Let’s save the file before we test the link.

Save your file.

OK, let’s see if the link works.

Press F12 to preview this page in Internet
Explorer.

In Internet Explorer, scroll down and click on this
link to test it.

If you followed the steps properly, this link should take you
back to your home page (i.e. “index.html”).

Now, you can toggle back and forth between these two pages
at will while previewing them within Internet Explorer!

Looking “Behind the Curtain” at the
HTML Code

This is a nice opportunity to take a look at the raw HTML,
the actual code that actually makes the page work.

Close all Internet Explorer windows and go back
to Dreamweaver.

View the file “index.html”.

It should already be opened (if not, go ahead and choose to
open it). More than likely, it is behind the window for
“resume.html”.

Scroll down the page and click once somewhere
inside the text “Professional Resume”.

As always, be sure to
save each file you are
working with
periodically. Remember,
selecting “Save” from
the “File” menu only
saves the file whose
window is currently
active (e.g.
“resume.html” in this
case). It is common to
have more than one file
window open at a time,
and it is easy to forget
about unsaved changes
to other file windows
currently open, but not
active.
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Notice that another HTML tag has appeared: <a>

The <a> tag is used to identify hyperlinks. If you click on
the <a> you will find that it too highlights the same block of
text as does the <p>. That is because both tags modify the
same text.

Let’s “peek behind the curtain” to see what actual HTML
code goes along with this <a> tag. Dreamweaver makes it
easy.

There are three buttons on the left hand side of the tool bar:

We have been in the “Show Design View” all along. But, let’s
click on the “Show Code and Design Views” button to get a
split screen of the HTML code and the document window.

Click on the “Show Code and Design Views”
button.

You can now explore your file from two vantage points at
the same time:  HTML code and the WYSIWYG document
window.

If you haven’t already, click once on the <a> tag
at the bottom of the document window.

WYSIWYG — what you
see is what you get

Notice that a third
HTML tag now
appears: <a>

Show Design View

Show Code View

Show Design
and Code Views
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This highlights all of the HTML associated with this tag.
We are not going to try to teach HTML coding at this point.
But take some satisfaction in knowing that Dreamweaver
converts each and every key press and mouseclick into the
proper HTML code for you. As you develop your web design
skills, you’ll almost assuredly have a need to learn more
about HTML code. So, also take some satisfaction in know-
ing that Dreamweaver will make it easy for you to live and
work in “both worlds”.

Again, be sure to save each file you are working with peri-
odically. Remember, selecting “Save” from the “File” menu
only saves the file whose window is currently active (e.g.
“resume.html” in this case).

Save each file after first making its file window
active.

Make a back-up of your “portfolio” directory onto
the hard drive of your personal computer.

Upload your files to a web server  (see Appendix).

Launch a web browser (i.e. Netscape or Internet
Explorer) and review your pages from the server
to make sure they are working properly.
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Session 3:
Adding Graphics to Your Web

Pages

Graphics are a very popular feature of the World Wide Web.
When used appropriately, graphics add an important ele-
ment to your web pages.  However, graphics can take up
large amounts of memory and require much longer to down-
load over the Internet than text. There is nothing more an-
noying than having to wait several minutes for a single web
page filled with unnecessary graphics to load.  Remember
also that too many graphics, especially when designed poorly,
can easily distract a person’s attention away from the im-
portant ideas you are trying to communicate in your web
pages.  Use graphics prudently to enhance your web site.

A little background about graphics
on the web

It is important to understand how and where graphics are
stored in web pages in order to successfully complete this
session.  Unlike regular word processing files, graphics are
not contained directly inside an HTML document, but in-
stead are stored as separate files on the disk.  An HTML file
merely “points” to the place where a graphic is stored on a
disk.  If found, the graphic is then loaded into the computer’s
memory and the graphic appears on the screen inside your
browser’s window.  If not found, an empty block is shown
instead.  If the path to the graphic is somehow broken, the
graphic will not appear.

Another important fact about graphics on the web is that
they have to be saved in one of a few very special file for-
mats.  The two most common graphic file formats are GIF
and JPEG.  Both file formats compress the graphic so that
it takes up as little space as possible when it is transmitted
over the Internet.  The GIF format is probably the most
common (and one of the oldest) and was introduced by
CompuServe as a way to help its subscribers transmit graph-
ics.  JPEG files allow greater resolution than GIF.  The only
file format we will work with in this session are GIF files.

Web pages load one
page at a time.
Therefore, instead of
designing one long
page with many
graphics, consider
breaking the page up
into a series of smaller
pages linked together.

The path to the graphic
file can be broken
either by later moving
the file or changing the
file’s name.

GIF stands for
“graphics interchange
format.”

JPEG stands for “joint
photographic experts
group.”
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Preliminary: Finding Already
Existing GIF and JPEG Files

Before we can add graphics to our web pages, we first have
to find some GIF or JPEG graphics. This guide does not
teach how to create your own, though it is not very difficult.
Most of the graphics applications available today allow you
to create and save your graphics in the GIF and JPEG for-
mats. Even the simple Paint program that comes free with
the Windows operating system has this feature. On the
Macintosh side, the drawing and paint features of
AppleWorks have this feature. But if you find yourself need-
ing to do a lot of graphics development work for the web,
buying programs such as Adobe PhotoShop or Macromedia
Fireworks will be a good investment.

So, where can one find existing GIF and JPEG images? For-
tunately, there are literally hundreds of web sites that give
away  web resources such as GIF and JPEG files for free.
At the end of this session is a listing of several of the best
ones. But, just to get us started with some consistency, I’ve
put a small collection of GIF files on the Internet for you to
download and copy. It is perfectly legal for you to copy and
use these on your web site.

Download a sample of GIF files to be used in this
session from one of the following URLs.

Windows users:
http://www.nowhereroad.com/dreamweaver/gifclipart.zip

Macintosh users:
http://www.nowhereroad.com/dreamweaver/gifclipart.sit

Both “.zip” and “.sit” files are compressed and are unusable
until they are uncompressed. The two most common appli-
cations to do this on a Windows computer are WinZip and
EnZip. On a Macintosh, Stuffit Expander is the most com-
mon. (Your computer may be set up to do this automatically
— if so, just pay attention to where the files are being saved
and uncompressed.)

Uncompress the files and put the resulting “GIF
clip art” directory on your computer’s desktop.

Open the directory containing the GIF files in
preparation for copying them to your root folder.
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The following window should be open on your desktop:

Copying These GIF Files to Your
Root Folder

The next step is a very important!  You have to copy (or
move) all of these GIF files to your root folder. If you fail to
do this properly, the graphics will not appear when you up-
load your site to a web server even though they may appear
when you test your pages locally.

Select all of the contents of the GIF clip files and
copy or move them into the “images” directory
inside your “portfolio” directory on your disk.

The site management
features of
Dreamweaver contains
several utilities to
prevent mistakes like
this from happening.
When you have a site
set up properly,
Dreamweaver will
“notice” if a graphic you
are about to use is
inside or outside of your
root folder. If outside, it
will ask you if you want
to copy to your root
folder. Very convenient!
(Again, instructions for
how to set up a web
site are contained in the
Appendix.)
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When done, your “images” directory should contain the fol-
lowing:

Now we are ready to use these GIFs in our web site!

Adding Already Existing GIF Files to
Your Web Pages

Dreamweaver makes it very easy to insert GIF files directly
into your pages with the Insert Image button on the Ob-
jects Palette.

Again, it is very important that the GIF files you want to
use are already located in the root folder of our web site
before using the Insert Image button.  The reason is that
Dreamweaver simply makes a reference to the graphic file
when you use this button.  If it is not already located in the
appropriate folder, you may break the link when you copy
your web site to the web server.  If you followed the last
series of steps correctly to download the small clip art col-
lection, followed by correctly copying them to your “images”
folder, you should be ready to add any of those GIF files to
your web site.  Let’s consider an example to clarify this.

Launch Dreamweaver and open your home page
“index.html”.

We simply now need to choose where to insert an image on
this page.   Let’s add a little flair to our home page by plac-
ing little red apples on either side of our name.

Insert Image button

You know, kinda like
an apple for the
teacher!
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Move the cursor to the point where you want to
insert the GIF file and click once.

The text insertion point (blinking vertical line) should be
blinking just in front of your name:

Click once on the Insert Image button in the
Objects Palette.

The “Select Image Source” window opens.

Navigate to the GIF file named “apple.gif” inside
the “images” directory:

Notice the URL of this graphic (“images/apple.gif”). This
translates into “starting at the root folder, you can find this
graphic inside of the images folder with the name apple.gif”.

Click “OK”.

The text insertion
point should be right
here

If this file is not there,
then you did not copy
the GIF files to your
images directory
correctly.  Take the time
now to repeat the
preceding steps
correctly.
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Here is the result:

Notice a couple of things. First, the apple graphic has handles
around it which allow you to easily resize it. You can also
easily move it to any other location on this page just by drag-
ging it.

The second thing to notice is the source location of this file
in the Property Inspector. It should not be surprising that
this again is listed as “images/apple.gif”.

Repeat the procedure to place another apple
graphic on the right side of your name.

When done, your screen should resemble the following:



40 Introduction to Dreamweaver 4 Session 3:  Adding graphics

Although you see two apples, there is really still just one
apple stored on the disk. The computer is smart enough to
make its own copy of the graphic on the screen. This saves a
lot of file space. You could place thousands of these apple
images on your page and still only need to have one copy on
the disk.

Here’s another example. I wrote the following at the bottom
of my home page.  Notice where the cursor is blinking.  This
is the place where the graphic will be inserted.

Move your cursor to the point where you want to
insert the GIF file.

Click once on the insert object button.

In the “Select Image Source” window, navigate
to the file named “undrcnst.gif”.

Click “OK”.
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The graphic you selected appears in your page.  Again, since
this graphic is stored in your root folder, the graphic and
the link to it will be available when the folder containing
your web site is copied to the web server.

Select “Save” from the “File” menu.

Adding a background to your web
page

The final technique we will show is how to add a textured
background to your web page.  This will help give your web
page a distinctive “feel.”  Any GIF file can be used also for a
background graphic.  The graphic will be automatically du-
plicated and “tiled” behind the existing text and graphics
on your web page.  For example, we will use the GIF file
named “paper1.gif” — it looks like textured paper.

To use this background graphic on our web page, we need to
access the Page Property window.

Select “Page Properties...” from the “Modify”
menu.

Alert!
Be very careful in
choosing backgrounds.
The wrong choice can
turn your web page into
a disaster!



42 Introduction to Dreamweaver 4 Session 3:  Adding graphics

The Page Properties window opens:

This window has a very interesting assortment of proper-
ties you can modify, all of which will modify the look and
feel of your web page. For example, this is the place where
you can change the background color or the default text color.
However, our goal is to change the background so that it
has the textured look of paper.

Click on the “Browse...” button to the right of
“Background Image.”

This also opens the “Select Image Source” window.

Navigate to the file “paper1.gif” in the
“backgrounds” directory (located in the
“images” directory in “portfolio”):

Click “OK”.

Like all graphics, a
background is stored as
a separate GIF (or
JPEG) file on the disk.
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This sends us back to the Page Properties window:

Notice the path to this image: “images/backgrounds/
paper1.gif”

Click “OK”.

The page has been transformed to appear as though the
text and graphics are on a piece of paper.

Save your file.

Make a back-up of your “portfolio” directory onto
the hard drive of your personal computer.

Upload your files to a web server  (see Appendix).

Launch a web browser and review your pages.

Any GIF or JPEG file
will work! You could
even choose a JPEG
containing your photo
— I don’t recommend
this design, but if you
want to see yourself on
the web, this is
probably the most
exaggerated way to do
it!
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Graphics Resources

There are lots of web sites where you can get free-to-copy
graphics to use in your web pages. Here are just a few:

The Clip Art Connection
http://www.clipartconnection.com/
One of the largest on-line clip art collections.

Animated Clip Art Gallery
http://www.earthcon.com/clipart/
This site provides many pages of free animated GIFs.

Free Backgrounds
http://www.bsugraphics.com/backgrnd.htm

Animated Clip Art
http://webclipart.miningco.com/msub2.htm

Remember, you can find your own resources by entering
keywords, such as “free gif clip art”, at any of the major search
engine sites (e.g. www.yahoo.com, www.altavista.digital.com,
and www.google.com).
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Appendix:
Getting Your Web Site on the

Internet
If you completed one or more of the sessions, you are prob-
ably anxious to actually get your HTML documents and re-
lated files (such as images) on the Internet so that you, col-
leagues, prospective employers, family, and others can ac-
cess them.  Your web site is not really on the web until all
the files have been correctly transferred to a web server.  This
step can only be done if you have direct access to the web
server onto which your web pages will be stored.

Let’s take a closer look at some of the fundamentals of ac-
cessing documents on the web.  For example, a web address
(i.e. URL) is just the path name to the HTML file starting
with the name of the server.  For example, the name of the
web server in the Department of Instructional Technology
at UGA is “it.coe.uga.edu”.  The HTML file is often buried
deep within a series of folders (i.e. directories) indicated by
a back slash (/) in the web address.  For example, consider
the following web address:

The HTML file (“dreamweaver2.html”) is located in a folder
named “workshops,” which is located in a folder named “stu-
dio” on the web server named “it.coe.uga.edu”.

There can be several ways to upload, or put, your files onto
a web server. If you have direct access to the web server, you
could just put in your floppy or zip disk and copy the files
directly to it.  However, the most common way to upload
files to a web server is through FTP, which stands for File
Transfer Protocol. FTP defines a standard for transferring
files between computers at a distance.  The powerful thing
about FTP is that the procedures even work if the comput-
ers on either end are Windows, Macintosh, Unix, etc. As long
as each has the appropriate FTP capability and there is a
way to connect the two computers (such as via a phone line),
it will all work.

Site management is one of the most powerful features of
Dreamweaver.  Built-in to Dreamweaver is a large assort-
ment of FTP capabilities.  Without these capabilities, you
would have to use a separate FTP application. WS_FTP is
the most common Windows FTP application and FETCH is
the most common Macintosh FTP application. If you are
already familiar with either of these tools, you can continue
to use them. However, once you experience the site manage-
ment features of Dreamweaver, you will probably wonder
how you ever got along with them.

web server
(i.e. computer)

name

folder
name

folder
name

HTML
document

it.coe.uga.edu/studio/workshops/dreamweaver2.html

FTP — File Transfer
Protocol
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If you are completely new to site management and have
never uploaded or downloaded anything via FTP software,
the good news is that you can start immediately with
Dreamweaver and let it handle virtually all of your FTP
needs.  It is even possible that you may never need to use
any other FTP application.

The reality, however, is that there are still a few things that
WS_FTP or FETCH can do that Dreamweaver cannot. One
example is deleting a directory from a remote site. So, it is
still to your advantage to become familiar with an FTP ap-
plication and to have it on hand for occasional use.  There
are also many good guides already available on how to use
them. For example, there is a nice overview of both tools at
the following web site:

http://www.arches.uga.edu/upload.html

Fudging our Root Folder for
Dreamweaver

We have been calling our “portfolio” directory our root folder
for our web site, and rightly so. But because Dreamweaver
is not a  complete FTP application like WS_FTP or FETCH,
it cannot do a very simple, but very important thing on a
web server — create an empty folder.  This limitation is
important now because unless we have an empty portfolio
folder on our web server, Dreamweaver will not be able to
consider our “portfolio” directory as the root folder for this
site.  So, either we use WS_FTP or FETCH to create an empty
portfolio directory on our web server, or we have to fudge a
little bit with Dreamweaver. We will do the latter so as to
avoid having to use any other applications at this point.  All
we have to do is create another directory within which we
will copy our “portfolio” directory.

On your disk, create a new directory called “My
Web Site”.
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Move your “portfolio” directory into the “My Web
Site” directory.

If you open “My Web Site”, portfolio should be inside:

If you have never uploaded a web site to a server before, I
know the logic behind doing this “root folder fudging” is very
confusing.  The bottom-line is that we are now ready to de-
fine a new site with Dreamweaver that will allow us to up-
load our portfolio site to a web server.
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Defining a New Site with
Dreamweaver

Dreamweaver allows you to set up any number of web sites.
How one defines a “web site” is an interesting exercise.  Any
collection of linked HTML documents can be considered a
web site.  If you only have one server account (either through
a commercial provider, a free service such as Yahoo.com, or
one at school), you would probably think of this account as
one web site.  However, a web site is really an arbitrary
defined entity — you decide on the boundaries for this.  For
example, we are considering the web-based portfolio that
you are building in this guide as a web site, even though it’s
probably going to be part of a larger site. It’s perfectly ac-
ceptable and logical to embed a smaller web site into a larger
one. The main point is that it should reflect your design
goals and work habits. Dreamweaver makes it easy to set
up as many sites as you like. So, defining a web site just for
our portfolio will make it easy to focus exclusively on the
“nuts and bolts” of its design. Yet, it may be part of a larger
site we might define later, called something like “All About
Me”, a site with a broader focus and aim. For example, its
design would probably be of a general scope that would or-
ganize subparts (e.g. professional portfolio, hobbies, major
projects, etc.) in an interesting way.

So, a web site is simply how you define it. Let’s turn our
attention to defining a web site in Dreamweaver for our
portfolio.

Launch Dreamweaver and be sure your disk with
your “My Web Site” directory (containing the
“portfolio” directory) is loaded.

You will probably have a blank “untitled document” opened
for you. That’s fine. We don’t need to open any files associ-
ated with our web site to continue.

Select “Site → New Site...” from the menubar.
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This opens the “Site Definition” window.  Notice the differ-
ent categories on the left.

We will start with the “Local Info” category, then work our
way down to other relevant categories. As the name sug-
gests, this part of the site definition describes where the
files can be found locally, meaning where they can be found
on our computer system. We start by entering a name for
our site.  This name is only used by Dreamweaver, so it’s OK
to make it as descriptive as you want — this name will not
be uploaded to the web server.

Enter “My Portfolio” in the text field beside “Site
Name:”

Next we need to tell Dreamweaver which folder on our com-
puter is the all important root folder.

Click on the graphic of a small folder to the right
of the text field beside “Local Root Folder”.
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Navigate to the “My Web Site” directory on your
floppy or zip disk so that “My Web Site” appears
in the text field beside “Select:”.

Click the “Select” button.

Next we need to type in the HTTP address for our web site.
This needs to be the address that we will eventually type
into a web browser to view the site. Obviously, this depends
first on the address of your web server, then on the path to
your account, and finally on the path to your portfolio. Let’s
explore a few examples.

I know many of you are working in a school environment
that gives you free web accounts. I have one at the Univer-
sity of Georgia using a server that we call ARCHES. I want
my portfolio to be at the top most level of my account (i.e.
not embedded in any other folders). This would be my HTTP
address:

http://www.arches.uga.edu/~lrieber/portfolio

The tilde (~) is commonly used on these sorts of accounts. It
means that there is other information about the path that
is intentionally omitted, kind of like how one uses an apos-
trophe in the word “can’t”. We know that two letters are
missing, but it’s still a word.

I also have a commercial web account for my
NowhereRoad.com web site.  If I were to put my portfolio
there, this would be the HTTP address:

http://www.nowhereroad.com/portfolio

Consult with your web server administrator if you have prob-
lems identifying your HTTP address. I’ll use the ARCHES
example for the rest of this guide.
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Enter your HTTP address.

Leave the two options on this screen checked: “Refresh Lo-
cal File List Automatically” and “Enable Cache”. The only
reason to turn either of these off would be if you are using a
very slow computer.

Great! We’re done with the local information for our web
site. On to the remote information.

Click on “Remote Info” in the Category list.

Notice that this HTTP
address is too long to fit
in the window.  It’s a
scrolling window, so it
can be along as you
need it — don’t worry if
part is “chopped off” on
the left as you type.
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We need to tell Dreamweaver how we intend to access our
site. The most typical way is via FTP (file transfer protocol)

Click on the triangle graphic beside “Access:”
to show the pop-up menu.

Select “FTP” from the list.

After you choose FTP, Dreamweaver displays the required
information fields.

Entering the correct information is critical here. There is no
room for error.  You might even have to use some “trial and
error” to identify the correct information for all the fields.
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Here is the window completed properly for my ARCHES
web server account:

Let’s explore each of the entries, one by one.

The FTP Host is the name of the web server and is almost
always the same name as the top most level of the HTTP
address.  Interestingly, in my case, the name is not exactly
the same — the “www.” is missing at the beginning.  In my
case, it won’t work any other way. If you can’t discover the
correct name on your own, you will need to check with your
web server administrator for this information.

The Host Directory is the name of the directory on your
web server into which all of your web files must be located.
Many servers use “public_html”. Another typical name is
“www”. Again, if these don’t work, check with your web server
administrator.

Your Login and Password were given to you when you set
up your server account.  For many students, these are the
same Login and Password that they use to check their email
on this account.

Leave the other options on this page unchecked.

That’s it. Let’s click “OK” to test the connection to our re-
mote server.

Click “OK”.

The Check In/Out”
option is a great feature
if you are developing a
web site with a team of
people. It will allow one
member of the team to
“check out” a page to
work on and will not
allow anyone else on
the team to make any
changes to the page
until the page is
checked back in. (The
only catch is that all
team members must
be using
Dreamweaver.)
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Dreamweaver gives us a little message about creating a site
cache.  With a large site, creating this cache can take a little
time, but it’s worth it because this cache will make other
site management processes much faster.

Click “OK”.

A new window opens containing our site:

This is a split window. On the right hand side are our local
files and the remote files will be on the left.  The left side is
blank because we do not have a live connection yet with our
web server. Let’s initiate the connection.

Click on the “Connect to remote host” symbol.

This symbol looks like two disconnected plugs.

If you correctly entered all of the necessary information,
Dreamweaver will correctly connect to your remote server
and list all of the files associated with the root folder.

Cross your fingers
while you do this to
hope that you entered
everything correctly!

Get the metaphor?
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If it didn’t work, you will receive any number of error mes-
sages.  A message like the following indicates that FTP host
information is incorrect:

A message like the following indicates an error in your login
or password (or both):

If your connection did not work, you will need to edit your
site to revise the connection information.  Just select “Site -
Define Sites” from the menubar...

...then choose to edit the “My Portfolio” site:
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It can take a few tries to get it all right.  The beauty of
Dreamweaver is that once you set up a site properly, it will
store this information permanently in your computer’s sys-
tem files. So, if you are using your own computer for all of
your Dreamweaver work, you only have to go through this
site definition process once.  If  you are working on more
computer, you would have to define the site for each com-
puter.

Uploading Your Web Site to a
Remote Web Server

To upload any or all of your site to the remote server, you
merely click on the file/s or folder/s you want to upload, then
click on the “Put File(s)” symbol (the blue arrow). We’ll go
ahead and upload the entire site at this point.

Select the “My Web Site” directory on your disk
in the Local Folder (right) side of the site window,
then click on the “Put File(s)” symbol.

When asked “Are you sure you wish to put the
entire site?”, click “OK”.

If you are doing your
web development in a
school’s computer lab,
you will have to define
a new site every time.
In this case, it may be
easier to just use
WS_FTP or Fetch.
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Dreamweaver then uploads (puts) all of the selected files to
your server and automatically refreshes the Remote Site
(left) side of the site window:

You are now on the web! Let’s test it with Internet Explorer
or Netscape to be sure everything is really on the Internet.

Testing Your Site

Launch either Internet Explorer or Netscape
Navigator and enter the URL of your web site.

Here again is the URL for my portfolio on the ARCHES
server at the University of Georgia:

http://www.arches.uga.edu/~lrieber/portfolio

If you uploaded your web site correctly and entered the URL
without a single error, it will appear in the browser win-
dow:
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Using the Site Window to Manage
your Site

You can update your web site as often as you like using
Dreamweaver. You can replace or add individual files or di-
rectories.

The site window is also used to manage all of your site de-
velopment. There is no longer a need to ask Dreamweaver
to open files from the disk. If you want to update a page, you
can double click on its symbol and Dreamweaver will open
it for you.  For example, let’s expand the portfolio link by
either double-clicking on its folder graphic or by clicking
once on the plus (+) sign to its left.

Expand the “portfolio” directory by clicking once
on the plus sign (+).

Open the “index.html” file by double-clicking on
its file symbol.

Go ahead and make a small change to this file. Perhaps add
a sentence somewhere near the top or change a word.

Modify this file in some way.

Save the file and close the file window.

Now, you can upload this single page to your web server
just by highlighting it on the Local Folder (right) side of the
site window and clicking on the blue arrow symbol for “Put
File(s)”.

Upload (put) this file to the server by clicking
once on the blue arrow symbol.
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Dreamweaver asks you if you want to include “dependent
files”. Dependent files are things like images and sounds
that are linked to this page. This is a handy option if you
made significant modifications to the page, such as adding
more graphics, Dreamweaver will automatically upload all
the graphics, sounds, etc. that are linked to this page to the
server for you. But, if you know you only changed the text,
which is very typical, you can click no.

Click “No”.

Your web site has been updated.

Other Useful Site Management
Features

There are a variety of other useful features you can access
from this window.

You can refresh your local folder and remote site by click-
ing on the Refresh symbol (blue circle with arrow).

You can view your files alphabetically, by size, by type, or by
date by clicking on the column headings in either view.
Caption: I tend to leave my view sorted by date so I see
which files I last modified.

Of course, you can download files from the server to your
disk with the “Get File(s)” symbol (downward pointing green
arrow). Of course, you have to be very careful when doing
this as this will overwrite your local file.

Refresh

Click once on any of
these column headings
to sort your listing by
that column.

Get File(s)
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Finally, Dreamweaver also one clever site management tool,
called Synchronize”, to allow you to quickly update all files
that have recently changed. The Synchronize feature can
be found in the Site menubar:

Given these powerful site management tools, you should be
able to quickly build and maintain the most sophisticated
of web sites.


